
 



Video Capture Help Contents
To learn how to use Help, press F1.

Using Video Capture
A complete guide to Video Capture with step-by-step instructions

Reference Information
Thorough explanations of Video Capture components

Technical Support
How to contact Ulead Systems if you have questions

Other MediaStudio Program Helps
Quick access to on-line help for all other MediaStudio programs



Reference Information
How to Use This Help
Menu Commands

          Ribbon  
Control Bar
Status Bar
Shortcuts
Glossary



Menu Commands
File Menu
Control Menu
View Menu
Setup Menu
Capture Menu
Palette Menu
Help Menu
Switch Menu

Related topic
Windows Control Menu



Using Video Capture
Video Capture basics
Connecting to a video source
Viewing your displayed video
Setting display options
Improving video display
Defining audio output
Using an MCI device
Capturing video



Control Bar

The Control Bar is located at the top of the video window below the menu bar (when the Control Bar on 
Top option is checked in the Preferences: Video Capture dialog box. When unchecked, the control bar 
appears above the status bar).

For more information, click on the appropriate area.



Status Bar

The Status Bar at the bottom of the Video Capture window displays useful information about the active 
video sequence and your system. For more information click on the appropriate area.



Capturing video
Capturing a video sequence
Capturing a color palette



Video Capture basics
Opening a video file
Playing a video file
Saving a video file
Exiting Video Capture



    File Menu

Open

Save As
Preferences
Exit
Recent Files List



    Preferences Submenu

Contains commands to customize the way you work in Video Capture.

Video Capture

File Formats



    Control Menu
Stop
Play/Pause
Fast Rewind
Fast Forward
Previous Frame
Next Frame
Begin
End

Go to
Repeat
Mark In
Mark Out

MCI Batch
Volume
Door Open



    View Menu
Playback Mode
Preview
Overlay
Center
Audio and Video
Video Only
Audio Only

Information
View Log
Hide/Show Status Bar
Hide/Show Control Bar
Hide/Show Ribbon



    Setup Menu

Video Format

Audio Format

Video Display

Video Source
MCI Device



    Capture Menu

Video
Single Frame
Display When Capturing



    Single Frame Submenu

Contains commands to setup the destination of a captured single frame.
To Clipboard
To Image Editor

To File



    Palette Menu

Capture Palette

Load Palette

Save Palette
Copy Palette
Paste Palette



    Help Menu
Contents
Search for Help On
How to Use Help
About Video Capture
About Ulead Products



    Switch Menu

This menu lists the names of the other MediaStudio programs. Click on a name to invoke the 
corresponding program. You can also access the Windows Program Manager, File Manager and 
Clipboard Viewer (if available).



    Windows Control Menu

Every window has its own control menu in the top left corner to manage the window itself. Some control
menus also contain an additional command such as Next or Run. These commands allow you to swap 
between windows.

Restore restores a window to its normal size (i.e. the size it was before being maximized or 
minimized)

Move allows you to move the window
Size allows you to change the size of the window
Minimize reduces the window to an icon
Maximize enlarges the window to fill all available space (either on screen or within a parent 

window)
Close closes the window
Switch To brings up the Windows Task List dialog box



Shortcuts

Video Capture has many shortcuts that allow you to access commands and open dialog boxes without 
having to go through the menus.

Click here to print this topic
Click here to close this window

File Menu
Ctrl + O Displays the Open dialog box
Ctrl + S Saves an existing video file
Ctrl + Q Exits Video Capture

Control Menu
Esc Stops the video sequence being played and returns it to the first frame
Space Starts playing the video sequence
Pg Up Skips back through the video sequence
Pg Dn Skips forward through the video sequence
<- Moves back a single frame
-> Moves forward a single frame
Home Goes to the first frame of the video sequence
End Goes to the last frame of the video sequence
Ctrl + F Allows you to rewind o fast forward the MCI device to a specified location
Ctrl + R Plays the video sequence in a continuous loop
F3 Selects an individual frame and/or the start of a selection area
F4 Defines the end of a selection area
Delete Opens the door if an MCI device is installed

View Menu
Ctrl + P Displays the video in Playback mode
Ctrl + E Displays a preview of the video you intend to capture
Ctrl + V Displays the video diectly from the capture board
Ctrl + I Displays the File Information dialog box

Capture Menu
F5 Displays the Video Capture dialog box
Ctrl + C Captures a single frame to the clipboard
F7 Captures a single frame to Image Editor
F8 Captures a single frame to a file

Help Menu
F1 Displays the contents for Video Capture Help
Shift + F10 Displays the contents for Windows Help

Miscellaneous
Double-click title bar Maximizes or restores the active window



Double-click status bar Displays the Video Capture dialog box
Esc Closes dialog boxes without making changes

Command line options 
/N or -N Does not display the logo when Video Capture is invoked



Video Capture
Allows you to customize several features of Video Capture.

Related topic
Video Capture dialog box



File Formats
Allows you to specify the file formats you want to use.

Related topic
File Formats dialog box



Exit
Closes the Video Capture program.



Recent Files List
This is the list of files you have opened recently.
You can choose the number of files displayed in this list in the Video Capture dialog box. Simply click on
a file to open it.



Play/Pause
Plays or pauses the video sequence in playback mode.

Shortcut key: Spacebar



Freeze/Unfreeze
When capturing, the Play button/command changes to Freeze. This freezes the video source on one 
frame, but continues to play in the background. Clicking on the Unfreeze button displays the video in 
the current position.

Shortcut key: Spacebar



Record
The Record button opens the Capture Video dialog box. This dialog box can also be accessed by 
choosing the Video command in the Capture menu.

Shortcut key: F5 (only when capturing)



Stop
Stops the video sequence and returns it to the first frame.

Shortcut key: Esc



Fast Rewind
Skips the video sequence backward in 10% intervals.

Shortcut key: Page Up



Fast Forward
Skips the video sequence forward in 10% intervals.

Shortcut key: Page Down



Previous Frame
Moves the video sequence backward by a single frame.

Shortcut key: Left Arrow



Next Frame
Moves the video sequence forward by a single frame.

Shortcut key: Right Arrow



Begin
Takes you to the beginning of the video sequence.

Shortcut key: Home



End
Takes you to the end of the video sequence. If you have marked an area, it goes to the end of the 
selection.

Shortcut key: End



Repeat
Plays the video sequence in a continuous loop.

Shortcut key: Ctrl + R



Volume
Allows you to change the volume of the video sequence being played.
You can also change the volume by clicking on the volume button in the status bar.

Shortcut key: Up and Down Arrow



Mark In
Selects an individual frame and/or the start of a selection area.



Mark Out
Defines the end of a selection area.



Door Open/Closed
Opens and closes the door if your video source is a video disc or VCR using a VISCA (Video System 
Control Architecture) protocol or compatible MCI driver.



Playback Mode
Allows you to view and play a video sequence you have just captured.

Note: The default mode is determined by the mode Video Capture was last in before exiting.



Preview
Displays the video as it would appear when captured.
The preview mode is useful if you want to experiment with various capture settings to see what a video 
sequence will look like after capturing.



Overlay
Displays the video directly from the capture board and is best for viewing only.
In overlay mode, the video passes through your PC's system to be captured, and as a result, the 
captured video is affected by the capabilities of your PC.



Center
Moves the Video Capture window to the center of the screen.

Note: This command is disabled if your video capture board does not support overlay mode.



Audio and Video
Allows you to select both the audio and video tracks when capturing or playing.



Video Only
Allows you to select only the video track when capturing or playing.



Audio Only
Allows you to select only the audio track when capturing or playing.



Information
Displays general information about your file, as well as the audio and video format. The same 
information can be accessed with the button in the status bar.

Related topic
File Information dialog box



Hide/Show Status Bar
Hides or displays the status bar at the bottom of the screen.



Hide /Show Control Bar
Hides or displays the control Bar.



Video Format
Allows you to determine the size of the video window, the image format and the data type.

Note: The dialog box may differ for different video capture boards.

Related topic
Video Format dialog box



Video Display
Allows you to change color variants such as hue, saturation, brightness and contrast.
If you are in Overlay mode, the changes you make are immediately reflected in your video image.

Note: The changes you make to colors are applied to your monitor's color scheme. As such, they do not
actually change the video signal. Therefore, any images you capture will not show the changes created 
in the Video Display dialog box.

Related topic
Video Display dialog box



Video Source
Allows you to define the settings and type of source you want to capture from.

Note: The dialog box may differ for different video capture boards

Related topic
Video Source dialog box



MCI Device
Allows you to control your video source directly from Video Capture, if you have an MCI (Media Control 
Interface) device connected to your video source.



Audio Format
Allows you to define the audio characteristics such as sampling rate, channel and sample size.

Note: If your PC has no audio capabilities, this command will be disabled.

Related topic
Audio Format dialog box



Single Frame: To Clipboard
Duplicates a frame onto the clipboard.



Single Frame: To Image Editor
Copies a frame to the Image Editor program.



Single Frame: To File
Allows you to save a frame under its own filename.

Related topic
Capture to File dialog box



Display When Capturing
Allows you to view the video on screen when capturing.



Capture Palette
Allows you to generate an Indexed 256 Color palette (8-bit data type only).

Related topic
Capture Palette dialog box



Copy Palette
Copies a palette onto the clipboard.



Save Palette
Allows you to save a palette to a specified file.

Related topic
Save Palette dialog box



Paste Palette
Pastes the palette copied onto the clipboard.



Load Palette
Loads the palette saved to a file.

Related topic
Load Palette dialog box



Contents
Starts Help and displays the topics in the Video Capture Help.



Search for Help On
Opens the Search dialog box containing keywords from the Help topics.



How to Use Help
Accesses the Windows guide to using Microsoft Help.



About Video Capture
Displays the Video Capture product information box.



About Ulead Products
Displays information about other products from Ulead Systems.



Connecting to a video source

Before you start displaying video make sure that Video Capture can receive video from your video 
source. This involves connecting your source to the video capture board and calibrating Video Capture 
so that it is tuned in to the correct settings.

1. Choose "Video Source" from the Setup menu to display the Video Source dialog box.
2. Specify the video connector, input format and video standard used by your video source.

Note: Some of the options in this dialog box will differ depending on your video capture board.
3. Click OK. The dialog box closes with the new settings.

Related topic
Video Source dialog box



Viewing your displayed video

When opening Video Capture, the program window appears as it was last viewed. To reposition or 
resize the window, you can either drag the borders of the window, maximize the window or choose the 
Center command from the View menu. The Center command resizes the program window and places it 
in the center of your screen.

Depending on your capture driver, you can view your video in either Overlay or Preview mode in the 
View menu. Overlay mode provides the best quality and smoothest motion. Preview mode displays the 
video as it would appear after capturing.



Setting display options

Use the Video Format command from the Setup menu to control the size of the frames in the video 
sequence and the data type of the displayed video. You can choose full screen (640x480) and RGB 
True Color for watching movies but for capturing purposes, you can choose smaller frame sizes and 
Grayscale.

1. Choose "Video Format" to display the Video Format dialog box.
2. In the Image dimensions list box, choose the frame size and specify the data type.

Note: Depending on your video capture board, you may also have a YUV 411 unpacked option. This 
takes its color scheme directly from the VRAM.
4. Click OK and the dialog box closes.

Related topic
Video Format dialog box



Improving video display

Use the Video Display command from the Setup menu to adjust the contrast, color and position of the 
displayed video. Any changes you make here only affects the display of the video in Overlay mode. The
display of video in Preview mode and any captured video sequences are not affected.

1. Choose "Video Display" to display the Video Display dialog box.
2. Move the slider indicators to adjust the hue, saturation, brightness and contrast values.
3. To change the red, green and blue pixel values of the image, move the slider indicators to the left 

or right.
If you are in Overlay mode, the changes you make are immediately reflected in your video image

4. Choose the Adjust button to display the Video Position dialog box. Use this to fine tune the 
position of video displayed in Overlay mode.

5. Choose the Effect button to display the Video Effect dialog box. Use this to apply special effects 
to the video image.

6. Click OK. The dialog box closes and the changes are reflected in the video window.

Related topics
Video Display dialog box
Video Position dialog box
Video Effect dialog box



Defining audio output

Use the Audio Format command from the Setup menu to define the audio characteristics of the sound 
track accompanying your captured video sequence. Exactly how you capture sound depends on your 
video source, video capture board and sound board (if you have one installed).

1. Choose "Audio Format" to display the Audio Format dialog box.

Note: This command is disabled if your PC has no sound board or video capture board does not 
support sound board functions.
2. In the Name combo box, select an option to record the audio data. The attributes of the option 

are displayed in the Attributes combo box.
If you select new attributes and wish to save them for later use, click on the Save As button. The 
Save As dialog box opens allowing you to assign a name to the attributes.

3. In the Format combo box, select a compression scheme. For recording 8 kHz files, try the IMA 
ADPCM. For other types, use the Microsoft ADPCM option.

4. Click OK. The dialog box closes and sets the audio characteristics.

Related topic
Audio Format dialog box



Capturing a video sequence

Use the Video command from the Capture menu to capture a video sequence. To capture a ten second 
video sequence at 15 frames per second:

1. Choose "Video" or press the Rec button to display the Capture Video dialog box.
2. In the Frame rate combo box, specify the number of frames to be captured each second.
3. Click on the Capture audio option (This is only available if it is supported by the hardware).
4. Select "Auto" from the Capture method group box and type 10 in the combo box.
5. For Capture destination select the File option and type in a filename (or capture to the default 

destination).
6. Click OK. The Capture Video message box appears. Click OK to start capturing.

Related topic
Capture Video dialog box



Capturing a color palette

Use the Palette command from the Capture menu to capture a new color palette.

1. Choose "Capture Palette" to display the Capture Palette dialog box.
2. Specify the number of frames you wish to capture. If your video source is outputting frames which

all contain similar colors, specify a low value. If colors are rapidly changing, specify a higher 
value.

3. Select the Auto Mode option. Calculate how long you want to capture for and then divide by the 
number of frames you will capture. For example, if you wish to capture 5 frames from 10 seconds
of video output, enter 2.

4. Click OK. The dialog box closes and the palette is captured.

Related topic
Capture Palette dialog box



Using an MCI Device

If you have an MCI (Media Control Interface) device connected to your video source, you can control 
your video source directly from Video Capture. For example, clicking on the rewind button in the control 
bar rewinds your video tape. Another advantage of having an MCI compatible device is that you can 
specify exactly which part of the video you wish to capture. All you have to do is mark the start and end 
frames to capture. Once marked, clicking on the Record button repositions your video source and 
begins capturing the selected frames.

In Video Capture, creating a selection using an MCI device is a simple matter of clicking on the mark in 
and out buttons in the control bar (or use the F3 and F4 shortcut keys respectively). Clicking either 
button changes the selection accordingly.

Note: If your video source is a video disc with a compatible MCI driver, you can open and close the 
door by choosing the Door Open/Close command from the Control menu.



Opening a video file

Use the Open command from the File menu to open video files previously saved to a hard disk, floppy 
disk, or network drive.

1. Choose the Open command to display the Open dialog box.
2. Select the AVI file extension from the List Files of Type list box.
3. Select the disk drive and directory containing the files. Use the Directories and Drives list boxes 

to access the drive and directory.
4. Click on the filename in the filename list box.
5. Select "Auto Play" if you wish to play the files after opening. Select "Mute" to silence the audio 

track of the video sequence.
6. Click OK. The dialog box closes and the file appears in the video window of Video Capture.

Related topic
Open dialog box



Finding files

If you want to open a file but you do not know or remember where it was saved, use the Browse button 
in the Open File dialog box to search for it. To find a file:

1. Choose the Open command to display the Open dialog box.
2. Click on the Browse button to open the Browse dialog box.
3. Select the disk drive and directory you want to browse. Use the Directories and Drives list boxes 

to access the drive and directory.
4. Click on the Scan button. Video Capture searches the path you have specified for files with a 

name matching that in the filename text box. Matching files are then listed in the filename list box.
5. Select the file you want to open from the filename list box by clicking on it.
6. Click OK. The Browse dialog box closes, returning you to the Open AVI File dialog box. The File 

and path name of the selected file will appear in the filename text box. To open the file, click OK.

Related topic
Browse dialog box



Playing a video file

Video Capture provides a full set of controls for playing video files. To play a file saved on disk or a file 
you have just captured, use the Play command in the Control menu. You can also click on the play 
button in the control bar or simply press the spacebar. Click on the pause or stop button to stop 
playback. You can also skip the video sequence forward or backward in 10% intervals or by a single 
frame.

For more information click on the appropriate button:



Saving a video file

Use the Save As command from the File menu to save a frame or video sequence for the first time.

1. Choose the Save As command to display the Save As dialog box.
2. Select the disk drive and directory you want to save to. Use the Directories and Drives list boxes 

to access the drive and directory.
3. In the filename text box, type the name of your file (up to eight characters). You do not need to 

enter the file extension.
4. Choose the Save to Album option if you wish to save the file to an album in Album's workspace or

in a newly created album.
5. Click OK. The dialog box closes, returning you to Video Capture.

If you want to configure the saving settings, click on the Options button to open the Save Options 
dialog box.

Related topics
Save As dialog box
Save Options dialog box



Exiting Video Capture

Use the Exit command in the File menu to exit Video Capture. You can also exit by:

double-clicking on the application control menu box.
clicking on the application control menu box and choosing "Close".



Open
File Name initially shows the AVI file extension; if you know the path and file you wish to open, 

enter it here or select it from the list box
List Files of Type lists Microsoft AVI file format and its extension
Directories shows the current path and any subdirectories under that path
Drives list all the available drives
Subject displays the subject assigned to the file (optional)
Description displays the description of the file contents (optional)
Auto Play when checked automatically plays the selected file in the preview thumbnail
Mute when checked silences all audio output of a video playing in the preview thumbnail
Preview thumbnail displays the contents of a selected file. Double-click to play and click to 

pause the file, or use the play/pause button
Info opens a dialog box containing information on the selected file
Browse accesses the Browse dialog box; use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic
Opening a file



Save As
File Name initially shows the AVI extension; enter the filename you wish to save to or select one 

from the filename list box to overwrite that file
List Files of Type lists the AVI file format and its extension
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Subject allows you to assign a subject to the file (optional)
Description allows you to enter a description of the file contents (optional)
Save Preview allows you to save a frame to be used as a preview. Move the slider indicator to 

select a frame 
Preview thumbnail displays the contents of the selected file
Save to Album allows you to choose whether or not to save a thumbnail of the image to an 

existing album
Album opens the Insert Thumbnails into Album dialog box in which you can place a thumbnail of 

the image into an existing or new album
Options accesses the Save Options dialog box for available compression schemes as well as 

advanced saving commands
Browse accesses the Browse dialog box; use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)

Related topic
Saving a file



Save Options
Target Playback Drive allows you to specify the data transfer rate of your storage device
Compressor shows the available compression schemes. A no compression option is also 

available
Quality slider bar allows you to control the compression of a file
Data Type shows the available data types of the currently selected video compression scheme
Data Track indicates the current track status
Configure provides additional compression options
Audio accesses the Audio Format dialog box where you can change the audio characteristics

Advance 
Clicking on the advance button reveals additional saving options. Clicking once again hides these
features.
Frame Rate allows you to change the current frame rate of the video sequence
Data Transfer Rate displays the data transfer rate selected from the Target Playback Drive in the

standard options. Change this rate to more closely match the data transfer rate of the target storage 
device

Key Frame for Every option allows you to determine the distance between "key" frames used by 
the compression scheme

Interleave Audio and Video when checked allows you to specify the interleave ratio between the
audio and video data

Pack Audio Data for Every allows you to determine when the next portion of audio data follows 
the video data

Pad Frames for CD-ROM is used to help make your CD-ROM more efficient in playback by 
standardizing the video data structure when saving

Related topic
Save As dialog box



Video Capture
Show Tooltips enable brief descriptions of Album components when the pointer is on them
Control Bar on Top places the control bar at the top of the video window below the menu bar. 

When unchecked, it is placed above the status bar
Play File When Opened starts playing the file immediately after opening
Return to First Frame After Playing returns the first frame after playing. When unchecked, the 

video stops at the last frame of the video sequence
Display Frame Numbers When Playing displays the frame number of each frame in the status 

bar when a video sequence is playing
Display Capture Options Before Capturing displays the Capture Video dialog box when the 

Rec button or F5 key is pressed. When unchecked, you capture immediately using the current capture 
settings

Number of File Names Kept specifies the number of files listed at the bottom of the File menu; 
click on a filename to reopen that file

Background Color determines the color of the background around the video window. You can 
choose from four preset options or define your own



Video Format
Image Dimensions specifies the frame size. Use the 1/8, 1/4, 1/2 and full options to select a 

frame size relative to the full screen. The list box contains a further 16 options
Image Format determines the data type of a captured video sequence

Related topics
Capture Video dialog box
Capturing a video sequence



Video Display
Hue distinguishes one color from another
Saturation defines the purity of a color. Increase the saturation value to intensify colors or 

decrease the value to "wash out" colors
Brightness controls the lightness and darkness. Increasing the brightness value makes the video

lighter, decreasing it makes the video darker
Contrast adjusts the difference between light and dark pixels. To make light pixels lighter and 

dark pixels darker, increase the contrast values. Decreasing the value reduces the difference between 
light and dark

Red, Green and Blue allows you to increase or decrease the red, green and blue pixel values in 
the image

Default button restores all the values to their default settings
Adjust displays the Video Position dialog box (if supported by your capture driver) where you can

adjust the position of the displayed video
Effect displays the Video Effect dialog box (if supported by your capture driver) where you can 

change the image and color shadows

Related topic
Capturing a video sequence



Video Position
Video Window X adjusts the horizontal position of displayed video
Video Window Y adjusts the vertical position of displayed video
Video Start X adjusts the point at which scanning of the video signal begins (horizontally)
Video Start Y adjusts the point at which scanning of the video signal begins (vertically)
Palette Skew micro-tunes the horizontal position of displayed video in the video window
Shift Clock Start micro-tunes the point at which scanning of the video signal begins (vertically)
Reset button restores all the values to their original default settings

Related topics
Video Display dialog box
Capturing a video sequence



Video Effect
Image Shadow retains a grayscale image of a frame
Color Shadow retains the colors of a frame
Reset makes the color and image shadow values zero
Clear refreshes the    video window

Related topics
Video Display dialog box
Capturing a video sequence



Video Source
Video Connector determines which video source to read data from. This allows you to choose 

one of three video devices configured with the Device: Setup command
Input Format refers to whether the images generated by your video source operate using a 

composite or S-Video signal
Standard button specifies the video signal received from the video source. This may be either 

NTSC or PAL depending on your video board
Default button restores all the values to their default settings

Related topic
Capturing a video sequence



Audio Format
Name lists the names of different audio formats
Save As opens the Save As dialog box where you save the audio format and its attributes to a 

specified name
Remove deletes the name from the name list
Format allows you to select the format of the audio data
Attributes lists the audio characteristics available

Related topics
Capture Video dialog box
Capturing a video sequence



Capture Video
Frame Rate specifies the number of frames to be captured each second
Capture Audio when checked enables the Audio button
Capture Method automatically captures a video sequence in the time specified in the second(s) 

text box. The manual button allows you to select which frames you want to capture
Capture Destination to File captures the video sequence directly to disk
Capture Destination to Memory captures data first to RAM and then to disk
Video displays the Video Format dialog box where you specify the video characteristics
Audio displays the Audio Format dialog box where you specify the audio characteristics
MCI button specifies the capturing method by using an MCI device
Browse accesses the Browse dialog box; use this dialog box to search for files
Subject allows you to assign a subject to the file (optional)
Save to Album allows you to choose whether or not to save a thumbnail of the image to an 

existing album
Album opens the Insert Thumbnails into Album dialog box in which you can place a thumbnail of 

the image into an existing or new album

Related topic
Capturing a video sequence



Capture to File
File Name initially shows the selected file extension, enter the filename you wish to save to or 

select a filename from the files list box to overwrite that file
List Files of Type lists the available file formats and their extensions
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options accesses the save options dialog boxes for file formats that provide options
Browse accesses the Browse dialog box; use this dialog box to search for files
Network allows you to connect to a network (only available if running Microsoft Windows for 

Workgroup)
Save to Album allows you to choose whether or not to save a thumbnail of the image to an 

existing album
Album opens the Insert Thumbnails into Album dialog box in which you can place a thumbnail of 

the image into an existing or new album



Capture Palette
Continuous Frames specifies the number of frames to be captured for the composition of the 

palette. The more frames selected, the greater the color options
Mode allows you to control the time delay in capturing frames
Auto spaces the capture of the frames as determined by the time specified in the entry box
Manual allows you to select whatever frames(s) you wish for the composition of the palette

Related topic
Capturing a video sequence



Save Palette
File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its 

filename from the files list box
List Files of Type shows the file extension for palettes (PAL)
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)



Load Palette
File Name initially shows the PAL extension ; if you know the path and name of the file you wish 

to load, enter it here or select it from the list box
List Files of Type shows the file extension for palettes (PAL)
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)



File Information

File
Filename shows the filename and path of the selected file
File Size shows the amount of space the file occupies on disk
Frame Rate indicates the number of frames that occur per second in the video sequence
Video Length shows the total frames in the video sequence
Video Duration indicates how long it takes to play the video sequence

Video
Format shows the data type and frame dimensions
Size refers to the disk space taken up by the video track
Compression specifies the compression scheme used to compress the file
Comp. Ratio indicates the ratio of the compressed file compared to its size without compression

Audio
Format shows the format of the file
Attributes shows the attributes of the audio file
Size indicates the disk space taken up by the audio track



Choosing an 8-bit palettized format uses an Indexed 256-Color palette. The default palette is grayscale.
To display color you need to capture a color palette from the video source. The 16-bit RGB option 
provides 32,768 colors while the 24-bit RGB setting offer 16.7 million colors but uses three times the 
memory of the 8-bit setting.
Depending on your video capture board, you may also have a YUV 411 unpacked option. This takes its 
color scheme direct from the VRAM. The result is effectively true color reproduction at a fraction of the 
disk space required for 24-bit RGB files.



Use this option when a magenta band appears on the left or right of the display area (This option is 
unavailable in HiColor graphics mode).



Use this option when a magenta band appears at the top or bottom of the display area (This option is 
unavailable in HiColor graphics mode).



Use this control when white scan lines appear on the left or right of the video window.



Use this control when white scan lines appear at the top or bottom of the video window.



This has a similar effect to the Video Window X control but provides a much finer control.



This has a similar effect to the Video Start X control but with a much finer control.



Some VGA boards do not have PLL (Phase Locked Loop) support. If your board does not have PLL 
support, this control will have no effect on the video display. The value can be anything from 0 to 1023.



8-bit samples use less disk space than 16-bit, however 16-bit gives greater range of sound (for human 
voice a 16-bit sample size is recommended).



Stereo sound is better, but takes up twice the memory of mono. For smaller speakers the advantage of 
stereo over mono is negligible.



11.025 kHz collects over 11,000 samples of sound per second. 22.050 kHz collects twice as much over 
a second. 44.100 kHz is used by professionals when high quality sound is important.

Note: The human voice is carried over telephone lines at the equivalent of 8-bit samples at 11.025 kHz.



A higher frame rate provide greater quality of video recording and more natural motion. A lower frame 
rate results in a more "jerky" effect.

Note: Capturing at 15 frames a second should be good enough to maintain continuous motion while 
saving system resources.



This is the quickest method for capturing data in real time. However, a slow hard disk and/or insufficient 
memory may result in lost frames.



This is a slower method than Capture Destination To a File and is limited by your amount of RAM. 
However, it is useful in capturing short sequences if your system cannot maintain the data transfer rate 
or you have problems with lost frames. After the sequence has been captured to memory, you are 
prompted to name a destination file.



If you are unsure of what the data transfer rate of your storage device is, consult your hard disk manual 
or use a utilities program such as Norton utilities or PC Tools to find out.

Note: If you wish to play the file on another PC, then you must save the file at the target PC's data 
transfer rate.



A higher frame rate will provide greater quality of video recording and more natural motion. A lower 
frame rate results in a more "jerky" effect. A frame rate of 15 frames per second is recommended . This 
should be enough to provide continuous motion, while at the same time saving disk space and 
processing time.



For example, a pack audio data rate of 1 results in an AVAVAV... file and a pack audio data rate of 5 
results in an AVVVVVA... file. (The length of the audio track remains the same, the only difference is 
how it is interleaved.



Moving the bar to the right produces higher file quality at the expense of motion. Moving the slider bar 
to the left produces more fluid motion, at the expense of picture quality and clarity.



The type of options is dependent on the compression scheme itself. If there are no options the button 
will be disabled.



You can sort by Name, Type, Size, and Date/Time. Sorted files can appear in ascending or descending 
order. Selecting an option sorts the files automatically.



File names can be entered with or without a file extension. If no extension is entered, the extension 
selected in the List Files of Type list box is automatically added.



The first field on the left indicates the current mode: Capture or Playback. The second field shows the 
number of frames while in playback mode, and the selected View command while in capture mode. The 
Audio/Video and Volume buttons allow you to select the playing mode and the volume of the video 
sequence. The Info button displays a box with information on the active file. The last button displays 
information about your system.



Other MediaStudio Program Helps

Image
Editor

Video
Editor



Ribbon

The ribbon contains icons for frequently used commands for quick access. Click above for details on 
each icon.



Go to
Allows you to fast-forward or rewind the connected MCI device to a specified point.

Related Topic
MCI Goto Dialog Box



MCI Goto
Go to specifies the time code to find using the MCI device



MCI Batch
Allows you to conduct several captures to different files from the same MCI device. The MCI Batch 
command opens the MCI Setting dialog box where you specify the filenames, starting, and stopping 
times for each capture

Related Topic
MCI Setting Dialog Box



MCI Setting
Device identifies the connected MCI device
Method determines how to capture video. Normal speed collects at the speed of the playback, 

dropping frames if the capture device cannot keep up. Step by Step collects without dropping frames.
Batch List shows all portions currently identified for capture

Opens the Add a new task dialog box for you to enter the filename and start and stop times for 
the capture

Opens the Edit a task dialog box for you to change the settings for the selected capture

Deletes selected tasks from the Batch List

Deletes all tasks from the Batch List

Loads a previously saved batch list

Saves the current Batch List as a file

Plays the currently selected task without capturing



Add a new task
File Name specifies the name for file created by the capture
Mark In specifies the starting time on the MCI device for the capture
Mark Out specifies the stopping time on the MCI device for the capture

automatically inserts the current MCI device position as the mark in time

automatically inserts the current MCI device position as the mark out time
Browse allows you to search your system for files



Edit a task
File Name specifies the name for file created by the capture
Mark In specifies the starting time on the MCI device for the capture
Mark Out specifies the stopping time on the MCI device for the capture

automatically inserts the current MCI device position as the mark in time

automatically inserts the current MCI device position as the mark out time
Browse allows you to search your system for files



Open Batch Capture
File Name initially shows the AVI file extension; if you know the path and file you wish to open, 

enter it here or select it from the list box
List Files of Type lists Microsoft AVI file format and its extension
Directories shows the current path and any subdirectories under that path
Drives list all the available drives
Subject displays the subject assigned to the file (optional)
Description displays the description of the file contents (optional)
Browse accesses the Browse dialog box; use this dialog box to search for files



Save Batch Capture
File Name initially shows the AVI file extension; if you know the path and file you wish to open, 

enter it here or select it from the list box
List Files of Type lists Microsoft AVI file format and its extension
Directories shows the current path and any subdirectories under that path
Drives list all the available drives
Subject displays the subject assigned to the file (optional)
Description displays the description of the file contents (optional)
Browse accesses the Browse dialog box; use this dialog box to search for files



View Log
Opens the View Log dialog box which shows the results of the last capture or batch capture.



Add MCI Task
Opens the Add a new task dialog box for adding a new capture task to the current batch Capture.

Related Topics
Add a new task Dialog Box

MCI Batch



Hide/Show Ribbon
Hides or displays the ribbon along the top of the window.



Open
Accesses the Open command from the File menu for opening previously saved video files.



Save

Accesses the Save command from the File menu for saving captured video to disk.
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Technical Support

If you have any questions or comments about this or any other Ulead products, we want to hear from 
you. Ulead has three offices to help you:

Before you call, please prepare the following information so we can offer you the best possible support:
The program name and serial number
Nature of the problem
Any error messages or dialog boxes that appear when the problem occurs
System information including the type CPU, your operating system, and any other programs 

running at the time the problem occurs.

If you decide to write or fax us, add printouts of the following:
AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD.INI

Note: You can obtain copies of these files quickly by running SYSEDIT.EXE in your Windows program 
directory.

In North and South America
Europe
International 



In North and South America

Our California offices are open Monday through Friday from 9:00 AM to 5:00 PM Pacific Standard Time.

Phone us at 

(310)-523-9393

Fax us at 

(310)-523-9399

Write to us at

Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502
Call the Ulead BBS at

(310)-523-9389 19200 bps (N,8,1)

Internet
support@ulead.com



International

Our international headquarters in Taiwan, R.O.C. has personnel fluent in English, French, German, and 
Chinese available to help. Office hours are Monday through Friday from 9:00 AM to 6:30 PM Taiwan 
time.

Phone us at 

+886 (2) 764-8599

Fax us at

+886 (2) 764-9599

Write to us at

Ulead Systems, Inc.
12F-A, 563 Chung Hsiao E. Rd.,
Sec 4,
Taipei, Taiwan, R.O.C.
Call the Ulead BBS at

+886-2-764-7585 19200 bps (N,8,1)

Internet
support@ulead.com



Europe

Our Customer SupportCenter in Germany is open Monday through Friday from 8:00 AM to 5:00 PM 
GMT.

Phone us at 

+49-2602-5685
Fax us at

+49 2602-16812
Write to us at

K&F Datentechnik
Wilhelm-Mangels_Strasse 8-10
D-56410 Montabaur
Germany
Call the Ulead BBS at

+886-2-764-7585 19200 bps (N,8,1)

Internet
support@ulead.com



The base product contains the ADK and access to public bulletins and messages on the Ulead BBS.



The base product with development support contains the ADK an complete technical support via fax, 
EMail, or BBS for sixty (60) days or twenty (20) hours, whichever comes first.



Development support offers extended technical support to those who already own the ADK via fax, E-
Mail, or BBS. Each contract covers sixty (60) days or twenty (20) hours, whichever comes first.




